Developing Re-usable Data Adapters in VS.NET

Presented by the DB2 Developer Domain

http://www7b.software.ibm.com/dmdd/

Table of contents

If you're viewing this document online, you can click any of the topics below to link directly to that section.

1. Before you start ................................................................. 2
2. Getting started ................................................................. 5
3. Creating reusable data adapters ........................................ 12
4. Sharing reusable data adapters ........................................... 19
5. Working with reusable data adapters ................................. 21
6. Web Services from reusable data adapters .......................... 29
7. Summary and resources .................................................... 31
8. Feedback ........................................................................... 33
Section 1. Before you start

About this tutorial

This tutorial demonstrates the power of the IBM Explorer's reusable data adapters, a new DB2 rapid application development (RAD) feature. To show the ease of building applications using reusable data adapters, this tutorial guides you through the steps required to develop components of a sample DADemo application using the DB2 "Stinger" Development Add-In for Visual Studio Technical Preview.

You will learn how to do the following from the IBM Explore:

° Add local and remote DB2 data connections.
° Create SQL procedures using a wizard.
° Create reusable data adapters from existing tables and procedures.
° Create reusable data adapters using a wizard.
° Create reusable data adapters using existing component tray data adapters.
° Define the result set shape of reusable data adapters including result sets for procedures.
° Preview and update data for reusable data adapters.
° Generate datasets for reusable data adapters and automatically generate data forms from data sets.
° Export and import reusable data adapters.
° Generate IIS WebMethods and deploy DB2 WebServices for reusable data adapters.

Should I take this tutorial?

This tutorial assumes that you are familiar with the concept of ADO.NET data adapters and data sets. The objective of this tutorial is not to build end-to-end application rather, it is to build reusable components for future application development.

You should take this tutorial:

° To learn about the new reusable data adapters' folder in the IBM Explorer.
° To develop reusable data adapters for tables and procedures.
° To share adapters across forms, projects, and users.
To generate IIS Web methods and deploy DB2 Web services for data adapters.

To learn more about the advanced features of the DB2 Development Add-In for Visual Studio .NET

Prerequisites

To complete the steps in this tutorial, you'll need the following software from both IBM and Microsoft:

- IBM DB2 V8.1.2 Application Development Client
- *DB2 "Stinger" Technical Preview*
- IBM DB2 V8.1 Server
- IBM DB2 SAMPLE database
- Microsoft Windows 2000, 2003, or XP with the Microsoft .NET framework V1.1
- Microsoft Visual Studio .NET 2003

About the author

Abdul Al-Azzawe is the DB2 Tools architect for Visual Studio .NET. He joined IBM in 1990 and worked in the Toronto lab for ten years as part of the DB2 engine development team with special focus on the Windows platform. In March of 2000, Abdul joined the IBM Silicon valley lab to architect the release of the DB2 integrated SQL debugger, the DB2 Development Center, and the DB2 Development Add-Ins for Visual Studio 6.0. In May of 2002, Abdul joined the
IBM San Francisco team to architect the integration with Visual Studio .NET, one of his proudest achievements in his career at IBM.

Abdul has written numerous technical articles and tutorials under DB2 Developer Domain covering a variety of DB2 application development topics. Abdul appreciates hearing feedback from actual developers about DB2 tools, and welcomes any suggestions for ways to improve these products. Abdul can be reached at abdulh@us.ibm.com.

Trademarks

IBM, DB2, and DB2 Universal Database are registered trademarks of the IBM Corporation in the United States and/or other countries.

Microsoft, Windows, and Visual Studio are registered trademarks of Microsoft Corporation in the United States, other countries, or both.

Other company, product and service names may be trademarks or service marks of others.
Section 2. Getting started

Application overview

This tutorial guides you through the steps required to develop reusable data adapters that may be used in a variety of windows or Web applications. The objective is not to build end-to-end application; rather, it is to build reusable components for future application development. You will:

° Create a reusable data adapter for the EMPLOYEE table with automatically generated select, insert, update, and delete statements.
° Create a reusable data adapter for QUERYEMPLOYEES and UPDATEEMPLOYEE SQL procedures.
° Define the shape of the result set of a reusable data adapter.
° Create a new reusable data adapter from scratch using a wizard.
° Create a reusable data adapter from an existing component tray data adapter that was generated using a drag and drop of the EMP_RESUME table.
° Generate data sets for reusable data adapters.
° Use the generated data sets to automatically create data forms or to define the type of component tray data sets.
° Import and export data adapters for sharing among team members.
° Generate IIS Web methods for data adapters.
° Deploy DB2 Web services for data adapters.
Registering the DB2 add-in

The DB2 "Stinger" Development Add-In for Visual Studio Technical Preview is automatically installed and registered when you install DB2; however, if you installed Visual Studio .NET after installing the DB2 application development client, then you will need to manually register the DB2 managed provider and the Add-Ins. This can be done using the following short-cut: Start => Programs => IBM DB2 => Set-up Tools => Register Visual Studio Add-Ins. This short-cut will attempt to register both the Visual Studio 6.0 and Visual Studio .NET Add-Ins.

To register the DB2 managed provider and development add-in from the command line, run `db2nmpreg`. To un-register them, run `db2nmpreg -u`. 
Starting Visual Studio .NET


This should launch the IDE and automatically load the DB2 Development Add-In. To verify that the DB2 Development Add-In is loaded, you should see IBM Explorer under the Visual Studio .NET View menu.

Creating the VB.NET project

To demonstrate some of the features of the IBM Explorer's reusable data adapters, create an application named DADemo using a WinForm designer.

To create a new WinForms Visual Basic .NET project:

1. From the Visual Studio .NET menus, select File => New => Project...
2. In the New Project window, select the Visual Basic Projects folder and choose the Windows Application project template.
3. Specify DADemo as the project name.
4. Click OK.
5. Save All.

A new Visual Basic project, DADemo, is created with a blank form.

Creating the DB2 SAMPLE database

This tutorial was designed to work with a DB2 for Windows SAMPLE database. You must ensure that the sample database has been created on your DB2 for Windows server.

To create the sample database, run the following command on the DB2 server:
db2samp1.

Note: The reason for requiring a local or remote DB2 for Windows server is that this tutorial describes the process for creating CLR (VB / C#) stored procedures that require the Microsoft .NET framework V1.1 in order for them to run.
Adding the DB2 data connection

To access DB2 server catalogs and new DB2 objects, you will first need to add the target DB2 server connection to the data connections folder of the IBM Explorer.

To add a local DB2 database connection:

1. Launch the IBM Explorer: View => IBM Explorer.
2. Right-click the Data Connections folder of the IBM Explorer, and select Add Connection. This opens the Add Database Connection window.
3. Note that by default, the value localhost is shown in the Server field. This allows you to access locally created or locally cataloged databases.
4. Select the desired database from the Database drop-down list.
5. Specify the user name and password to use for the database. You can leave these fields blank if you want to use the Windows integrated security, which is your current log-on user name and password.
6. Click Test Connection to ensure that you have proper connectivity.
7. Click OK to add the connection.

To add a data connection for a remote SAMPLE database on a remote DB2 for Windows server, you need to know the remote server host name or IP address, port number, and database alias. Follows these steps:

1. Launch the IBM Explorer: View => IBM Explorer.
2. Right-click the Data Connections folder of the IBM Explorer, and select Add Connection. This opens the Add Database Connection window.
3. In the Server field, enter the remote server host name or IP address followed by a colon and the port number. For example, enter azzawe2.svl.ibm.com:446.
4. In the Database field, enter the name of the remote database. For example, enter RemoteDB.
5. Specify the user name and password to use for the remote database connection.
6. Optionally, specify the Default owner, which is your user id, to be used as the schema in the wizards.
7. Click Test Connection to ensure that you have proper connectivity.
8. Click OK to add the connection.

Once the data connection is created, the server catalog information will be retrieved in an asynchronous fashion to populate the Tables, Views,
Creating the QueryEmployee procedure

In this step, you will create an SQL procedure that will be used later as the select command of a data adapter. The QueryEmployee procedure returns the list of employees in a given department number passed as an input parameter.

To create the QueryEmployee procedure:

1. Right-click the Procedures folder of the SAMPLE data connection and select **New => SQL Procedure**. The opens the Create DB2 SQL Procedure wizard.
2. Click **Next** to go to the Identification step. Specify the desired Schema, **Procedure name** = QUERYEMPLOYEE, **Comment** = Query base employee info for a specific department.
3. Click **Next** to go the SQL Statements step. Alter the default SQL statement to be as follows (make sure to modify ABDULH to the appropriate schema name for the EMPLOYEE table):

   ```sql
   SELECT EMPLOYEE.EMPNO, EMPLOYEE.FIRSTNME, EMPLOYEE.LASTNAME, EMPLOYEE.SALARY FROM ABDULH.EMPLOYEE WHERE EMPLOYEE.WORKDEPT = :inWorkDept
   ```
4. Click **Next** to go the Parameters step. Ensure that the parameter **INWORKDEPT** of type CHARACTER(3) is in the list.
5. Click **Finish**.

If you have entered everything correctly, the create procedure task executes successfully and you should see the new procedure added to your data connection's procedures folder.

To test that the procedure is working correctly, follow these steps:

1. Expand the Procedures folder.
2. Right-click the new **QUERYEMPLOYEE**, and select **Run Procedure**.
3. In the Parameter Values window, uncheck the **Null** option, and specify a value of **D11**.
4. Click **OK**.

You should see the list of employees in department D11.
Creating the UpdateEmployee procedure

In this step, you will create an SQL procedure that will be used later as the update command of a data adapter. The UpdateEmployee procedure modifies the base information for a single row in the employee table using a specific employee number.

To create the UpdateEmployee procedure:

1. Right-click the Procedures folder of the SAMPLE data connection and select New => SQL Procedure. This launches the Create DB2 SQL Procedure wizard.
2. Click Next to go to the Identification step. Specify the desired Schema, Procedure name = UPDATEEMPLOYEE, Comment = Update base info for a specific employee.
3. Click Next to go the SQL Statements step. Alter the default SQL statement to be as follows (make sure you modify ABDULH to the appropriate schema name for the EMPLOYEE table):
   
   ```sql
   UPDATE ABDULH.EMPLOYEE SET
   EMPLOYEE.FIRSTNME = :inFIRSTNME,
   EMPLOYEE.LASTNAME = :inLASTNAME,
   EMPLOYEE.SALARY = :inSALARY
   WHERE EMPLOYEE.EMPNO = :inEMPNO
   ```
4. Click Next to go the Parameters step. Ensure that these parameters are listed: INEMPNO as CHARACTER(6), INFIRSTNME as VARCHAR(12), INLASTNAME as VARCHAR(15), INSALARY as DECIMAL(9,2).
5. Click Finish.

If you have typed everything correctly, the create procedure task executes successfully and you should see the new procedure added to your data connection’s procedures folder.

To test that the procedure is working correctly, follow these steps:

1. Expand the Procedures folder.
2. Right-click the new UPDATEEMPLOYEE, and select Run Procedure.
3. In the Parameter Values window, uncheck all of the entries in the Null column, and specify the values: INDEPTNO = 000010, INFIRSTNME = ABDUL, INLASTNAME=AL-AZZAWE, INSALARY = 50000.00.
4. Click OK.

The procedures should run successfully.

Note that when you retrieve the data from the EMPLOYEE table and check the
entry with EMPNO 000010, you will see that it was not updated! This is because an automatic ROLLBACK is being issued when you do a test run of a procedure from IBM Explorer.
Section 3. Creating reusable data adapters

Overview

In this section you will create a number of reusable data adapters under the Data Adapters folder of the SAMPLE data connection in the IBM Explorer. Reusable data adapters are a great usability feature of the DB2 Development Add-In Technical Preview. They may be used across multiple win/web forms, across multiple projects, and shared among multiple users.

Some of the key features of the reusable data adapters include:

° Drag & drop onto winform and webform designers.
° Generation of data set classes for inclusion in existing CLR projects.
° Using the data form wizard to quickly add functionally rich data forms to your project utilizing the automatically generated data adapter data sets classes.
° Direct design-time preview of data adapter data in read/write mode.
° Generating Web methods and Web services for data adapters or commands.
° Import and export of one or more data adapters to/from the file system as XML files.

This section will demonstrate the variety of ways to create reusable data adapters.

Creating a reusable data adapter from a table

In this step, you will create a reusable data adapter for the EMPLOYEE table. The data adapter generated here is similar to a data adapter that is generated through a drag and drop from the IBM Explorer onto a form designer.

To create a reusable data adapter from a table:

1. Expand the Tables folder for the SAMPLE database in the IBM Explorer.
2. Select the EMPLOYEE table.
3. Right-click the table and select New => Data Adapter.
4. Note that a new data adapter, db2DataAdapeter1, is now added to the Data Adapters folder of your SAMPLE data connection.
5. Right-click the new data adapter and select Rename.
6. Set the name of the data adapter to db2TableDA
You can see the various data adapter command by right-clicking the new adapter and selecting **Configure Data Adapter**.

---

**Creating a reusable data adapter from procedures**

In this step, you will create a reusable data adapter for the QUERY EMPLOYEE procedure. Unlike a data adapter generated for a table, only the Select Command of the data adapter will be initialized for the selected procedure. The remaining command, if required, will have to be specified manually.

To create a reusable data adapter from a procedure:

1. Expand the Procedures folder for the SAMPLE database in the IBM Explorer.
2. Select the QUERYEMPLOYEE table.
3. Right-click the table and select **New Data Adapter**.
4. Note that a new data adapter, db2DataAdapter2, is now added to the Data Adapters folder of your SAMPLE data connection.
5. Right-click the new data adapter and select **Rename**.
6. Set the name of the data adapter to db2ProcedureDA.

---

**Defining the data adapter result set shape**

When creating a data adapter for a table, view, or an SQL query, the parser will determine the shape (i.e. list of output columns) for the Select Command. This however is not possible when the Select Command is a procedure, as procedures may return multiple result sets or result sets that are conditional.

Although defining the shape of the Select Statement is optional, it allows for proper data set generation and Web service creation. The Configure Data Adapter wizard allows you to either manually define this shape or discover it by issuing a test run for the stored procedure. In this step, you will manually define this shape.

To define the result set shape for a data adapter:

1. Right-click the db2ProcedureDA data adapter node and select **Configure Data Adapter**.
2. In the DB2 Data Adapter Configuration wizard, click **Next** twice to go to the SQL Select Statement step.
3. Click **Mapping**. This opens the Data Table Mapping window to define the result set shape.
4. Specify the value `EMPLOYEE` for the Data set table field.
5. Click **Import** to import column types from the existing `EMPLOYEE` table. This allows you to manually define the result set shape.
6. In the Import Table window, select the schema for which the `EMPLOYEE` table from the SAMPLE database belongs. This could be your user id.
7. From the Available list, move the `EMPLOYEE`'s `EMPNO`, `FIRSTNME`, `LASTNAME`, and `SALARY` to the **Selected** list.

![Import Table](http://www7b.software.ibm.com/dmdd/)

Presented by the DB2 Developer Domain

8. Click **OK**.
9. In the Data Table Mapping window, re-arrange the columns order so that they are listed as `EMPNO`, `FIRSTNME`, `LASTNAME`, and then `SALARY`. 
10. Click **OK**.
11. Click **Finish**.

---

**Modifying a reusable data adapter for procedures**

For data adapters that are created from procedures, only the Select Command is setup automatically for you. In this step you will define the Update Command of the data adapter.

To set the update command for the data adapter to invoke the `UPDATEEMPLOYEE` procedure:

1. Right-click the db2ProcedureDA data adapter node and select **Configure Data Adapter**. This opens the DB2 Data Adapter Configuration wizard.
2. Click **Next** to go to the SQL Statement Options step. Uncheck the INSERT and DELETE statements, and check the UPDATE statement.
3. Click **Next** to go to the SQL SELECT Statement. Do nothing.
4. Click **Next** to go to the SQL UPDATE Statement. Do the following:
   1. Switch the SQL UPDATE command type list box to **Procedure**.
   2. In the Schema name list box, select your user ID.
   3. In the Procedure name list box, select the `UPDATEEMPLOYEE` procedure.
5. Click **Parameters**. This opens the DB2 Parameter Specifications window. Do the following:

1. For the INEMPNO parameter, select or type **EMPNO** for the source column, and select the **Current** entry for the Source version.
2. For the INFIRSTNME parameter, select or type **FIRSTNME** for the source column, and select the **Current** entry for the Source version.
3. For the INLASTNAME parameter, select or type **LASTNAME** for the source column, and select the **Current** entry for the Source version.
4. For the INSALARY parameter, select or type **SALARY** for the source column, and select the **Current** entry for the Source version.
5. Click **OK**.
6. Click **Finish**.

You now have a data adapter that has a Select Command and an Update Command defined.

---

**Creating a reusable data adapter using wizard**

In these steps, you will create a data adapter using the DB2 Data Adapter Configuration wizard.

To create a new data adapter:

1. Right-click the Data Adapters folder and select **New Data Adapter**. This will launch the DB2 Data Adapter Configuration wizard.
2. Click **Next** to go to the SQL Statement Options step. Uncheck the UPDATE and DELETE statements.
3. Click **Next** to go to the SQL SELECT Statement. Type `SELECT * FROM DEPARTMENT`.
4. Click **Mapping** and note that all of the resulting columns are automatically detected. Click **OK**.
5. Click **Next** to go to the SQL INSERT Statement. Click **Generate** to generate this statement from the select statement.
6. Click **Finish**.
You should see a new data adapter, db2DataAdapter1, added to your Data Adapters folder.

Creating a reusable data adapter from a form

While developing WinForm or WebForm applications, you typically make use of data adapters to access your data and generate datasets. With the DB2 Development Add-In, you can turn the existing data adapters in your form's component tray into reusable data adapters under a compatible data connection in the IBM Explorer.

First, follow these steps to automatically generate a component tray data adapter:

1. From the Solution Explorer, expand the DADemo Visual Basic project.
2. Double click on Form1.vb. This will open the form in design mode.
3. From the SAMPLE data connection in IBM Explorer, drag and drop the EMP_RESUME table onto the form.
4. Save All.

You will see that db2Connection1 and db2DataAdapter1 have been added to the Form1.vb component tray.

To generate a reusable data adapter from a component tray data adapter:

1. Right-click the db2DataAdapter1 object in the Form1.vb component tray and select Add to Connection properties view.

Since there already is a db2DataAdapter1 entry in the Data Adapters folder, this new data adapter will be added as db2DataAdapter2.
Section 4. Sharing reusable data adapters

Exporting reusable data adapters

The data connection Data Adapters are persisted as part of the data connection userCache.xml file under %APPDATA%/IBM/vsnet. In order for you to share data adapters with other users, the DB2 add-in allows you to export one or more data adapters to an XML file.

Once exported, you can share this XML file with other developers or check it into the Visual Studio .NET configured source control management system.

To export all of your data connection reusable data adapters:

1. Expand the SAMPLE data connection.
2. Right-click the Data Adapters folder and select Export to File. This opens the Export Data Adapter save file window.
3. Choose a proper new file path and name for saving the data adapters XML file. For the demo, use the c:\test folder and the sample_adapters file name.
4. Click Save.

If you now explore your c:\test file directory, you will see the sample_adapters.xml file. This file contains the XML definition of all the data connection reusable data adapters.

If you want to export a specific reusable data adapter, follow the same steps above with the exception of selecting Export to File from the pop-up menu for the specific data adapter you want to export.

Importing reusable data adapters

You can import one or more data adapters from an exported XML file into the data adapters folder of a data connection using the DB2 add-in.

To import reusable data adapters from an exported XML file:

1. Expand the SAMPLE data connection or any other data connection where you want your imported adapters to be added.
2. Right-click the Data Adapters folder and select Import from File. This opens the Import Data Adapter open file window.
3. Choose a proper existing file path and name for loading the data adapters XML file. For the demo, use the previously exported c:\test folder and the sample_adapters.xml file name.

4. Click Open.

Note:

The import action will not validate that the SQL text or procedures defined in the imported data adapters are valid for the data connection where they are being imported. This validation is not always possible as some of the reference objects may have been filtered out. Also note that the alternative of validating the SQL on the database server using a live connection may be an expensive operation.
Section 5. Working with reusable data adapters

Previewing data from reusable data adapters

As with component tray data adapters, you can preview data for any reusable data adapter in the IBM Explorer. This action will also allow you to modify the results by adding, removing, and updating result set rows provided that the data adapter has the appropriate command defined.

To preview the data for the db2TableDA reusable data adapter:

1. Expand the SAMPLE data connection.
2. Right-click the db2TableDA node of the Data Adapters folder and select Preview Data. This opens the [Data] view for the db2TableDA data adapter.

You can insert, delete, update, cancel updates, commit updates, or refresh your data adapter data using this [Data] designer.

The same set of steps may be followed to preview the data of db2ProcedureDA. Note however that for db2ProcedureDA, the only operations supported are refresh and update of existing records. You can not delete or insert new records as these data adapter commands have not been defined.

When you preview the data of a data adapter that requires input parameters,
such as db2ProcedureDA, the Parameter Values window is first displayed to allow you to specify the values of the input parameters.

Feel free to experiment with various values, such as D11, E10, ...etc.

Designing forms with reusable data adapters

As with most objects in the IBM Explorer, you can drop reusable data adapters onto a win or Web form designer and then bind your form controls to the data set generated for the dropped data adapter.

To add the db2ProcedureDA data adapter to your Form1.vb component tray:

1. From the Solution Explorer, expand the DADemo Visual Basic project.
2. Double click on **Form1.vb**. This will open the form in design mode.
3. From the SAMPLE data connection in IBM Explorer, select **db2ProcedureDA** data adapter.
4. Drag and drop the db2ProcedureDA data adapter onto the form or click **Drop On Designer**.
5. Save All.

A new db2ProcedureDA1 is added to the Form1.vb component tray. Since you already have a matching db2Connection1 ADO.NET connection object, no new connection is added.

You can validate that the data adapter has been added correctly by launching the DB2 Configure Data Adapter wizard for the new data adapter.
Generating data sets for reusable data adapters

Up to now, you have been accustomed to generating data sets for your component tray data adapters and adding an instance of that dataset automatically to your component tray.

The DB2 reusable data adapters support now allows you to easily generate and add new data sets to your projects without having to use the component tray. To generate a data set for the db2TableDA data adapter and add it to your DADemo Visual Basic project:

1. From the SAMPLE data connection in IBM Explorer, right click the db2TableDA data adapter and select Generate Data Set. This will launch the db2TableDA[DataSet] special designer.
2. Select the DADemo project, and choose the option to Add to new Data Set with a default name of db2DataSet1.
3. Click OK.

Note that a new entry, db2DataSet1.xsd, is now added to your DADemo Visual Basic project. You can view the design of this data set by double clicking on this new project entry.
Creating data forms from reusable data adapters

Visual Studio .NET provides a special data form wizard that automatically generates data forms from data set definitions. This rapid application development feature can come in very handy when trying to quickly put together an application prototype.

Combing this feature with the DB2 support for generating data sets from reusable data adapters, you can now more quickly and more efficiently generate these data forms with little or no coding.

To generate a data form for db2TableDA using the generated db2DataSet1.xsd:

1. Right-click the DADemo project and select Add => Add New Item. This opens the Add New Item window.
2. Select the Data Form Wizard project item template and click Open. This will launch the Data Form wizard.
3. Click Next to go to the Choose data set step. Select Use the following dataset. The DADemo.db2DataSet1 entry should be pre-selected.
4. Click Next to go to Choose methods to load and update. Check the option to include an update button and keep the [None] selections.
5. Additional options may be specified to further customize the layout of the
data form, such as to use a data grid or individual row column controls. For the purposes of this tutorial, keep the defaults and simply click Finish.

A full-featured data form, DataForm1.vb, is now added to your DADemo project. All that is left to do is to code the Load and Update buttons. The Cancel All action is already implemented for you.

You can simply drag and drop the db2TableDA reusable data adapter from the IBM Explorer, drop it on the form, and then code the two methods as follows:

```vbnet
Private Sub btnLoad_Click( ByVal sender As System.Object, ByVal e As System.EventArgs) Handles btnLoad.Click
    Me.objdb2DataSet1.Clear()
    Me.db2TableDA1.Fill(Me.objdb2DataSet1)
End Sub

Private Sub btnUpdate_Click( ByVal sender As System.Object, ByVal e As System.EventArgs) Handles btnUpdate.Click
    Me.db2TableDA1.Update(Me.objdb2DataSet1)
End Sub
```

Now you have a fully functional DataForm1 data form in your DADemo project!
Creating typed data sets from reusable adapters

Another interesting feature of Visual Studio .NET is the ability to drag a data set object from the Toolbox's Data tab and drop it on a form designer. You can then specify the type definition of this data set based on existing project data sets.

Combining this feature with the DB2 support for generating data sets from reusable data adapters, you can now more quickly and more efficiently generate these form designer data sets.

To generate a form designer data set for db2TableDA using the generated db2DataSet1.xsd:

1. Select the DADemo project.
2. Double click the Form1.vb project item. This will open the form in design mode.
3. From the Data tab of the Visual Studio .NET Toolbox, drag the data set control and drop it on the form. This opens Add Dataset window.
4. Select the Typed dataset option. The DADemo.db2DataSet1 should be pre-selected.
5. Click **OK**.

You should see Db2DataSet11 ADO.Net object added to your Form1.vb component tray. This data set object is now properly defined using the previously generated db2DataSet1.xsd data set. You can now easily bind your form controls to this new data set!

---

**Extending data sets with reusable data adapters**

We have seen how easy it is to generate a new data set directly from the IBM Explorer's Data Adapters folder. In this step, you will take this further by extending the definition of an existing data set by generating into it the data set definition of a reusable data adapter data.

To extend the db2DataSet.xsd file with the data set definition of db2DataAdapter2:

1. From the SAMPLE data connection in IBM Explorer, right-click db2DataAdapter2 data adapter and select **Generate Data Set**. This will launch the db2DataAdapter2[DataSet] special designer.
2. Select the DADemo project and choose the option **Select existing Data Set** with the data set entry of **db2DataSet1**.

3. If you are prompted to overwrite your older db2DataSet1, accept this option.
4. Click **OK**.
**Note:** This feature has not been fully implemented in the Technical Preview.
Section 6. Web Services from reusable data adapters

Generating IIS WebMethods from reusable data adapters

Up to now, you have been accustomed to manually coding Web methods that either execute SQL statements or invoke procedures. The DB2 "Stinger" Development Add-In for Visual Studio Technical Preview will now enable you to automatically generate code for IIS Web methods corresponding to each of the data adapter commands. These Web methods are generated in a class file that is added to an existing Web project in your solution.

To generate IIS Web methods for the db2TableDA data adapter:

1. From the SAMPLE data connection in IBM Explorer, right-click the db2TableDA data adapter and select Generate Web Method. This will launch the Generate Web Method simple designer.
2. Using the designer you can choose the target Web project and the generated Web class name.
3. When you're ready, click OK.

The Web methods will now be generated in a C# or VB.NET class file and automatically added to your Web project.

Note: This feature has not been fully implemented in the Technical Preview.

Deploying DB2 WebServices for reusable data adapters

Apart from automatic code generation of Web methods for developing IIS-based Web services, you can now directly deploy DB2 Web services to local or remote DB2 servers that are configured as having embedded application servers. Depending on your installation, this feature may not be available on all your DB2 servers.

You can deploy DB2 Web services at the data adapter level to create operations for all data adapter commands or at the individual command level. An automatic test client can be generated and will be shown in your Web browser.
To deploy a DB2 Web service for the db2ProcedureDA data adapter:

1. From the SAMPLE data connection in IBM Explorer, right-click the db2ProcedureDA data adapter and select **Generate Web Service**. This will launch the Generate Web Service simple designer.

2. Using the designer you can customize the names and comments of your Web service operations that corresponds to the individual data adapter commands.

3. Make sure you check the option to generate a test client.

4. When you're ready, click **OK**.

The Web service will now be deployed to the DB2 embedded application server and the test client for the various Web service operations will be shown.

**Note:** This feature has not been fully implemented in the Technical Preview.
Section 7. Summary and resources

Summary

This tutorial demonstrated the ease of developing applications using the reusable data adapters feature of the DB2 Development Add-In Tech-Preview release.

Using the easy to follow instructions for building the sample DADemo application, you have learned how to do the following from the IBM Explore:

° Add local and remote DB2 data connections.
° Create SQL procedures using a wizard.
° Create reusable data adapters from existing tables and procedures.
° Create reusable data adapters using a wizard.
° Create reusable data adapters using existing component tray data adapters.
° Define the result set shape of reusable data adapters including result sets for procedures.
° Preview and update data for reusable data adapters.
° Generate datasets for reusable data adapters and automatically generate data forms from data sets.
° Export and import reusable data adapters.
° Generate IIS WebMethods and deploy DB2 WebServices for reusable data adapters.

All of the tasks required to build this application were done from within the IDE itself, demonstrating the tight integration of the DB2 application development tooling in this environment.

Resources

The following IBM resources should prove useful for you:

° DB2 Development Add-Ins Technical Preview - An Overview
° DB2 "Stinger" Technical Preview
° DB2 Developer Domain for additional technical articles and tutorials (http://www.ibm.com/software/data/developer)
The following Microsoft resources should also prove useful for you:

Section 8. Feedback

Your feedback

Colophon

This tutorial was written entirely in XML, using the developerWorks Toot-O-Matic tutorial generator. The open source Toot-O-Matic tool is an XSLT stylesheet and several XSLT extension functions that convert an XML file into a number of HTML pages, a zip file, JPEG heading graphics, and two PDF files. Our ability to generate multiple text and binary formats from a single source file illustrates the power and flexibility of XML. (It also saves our production team a great deal of time and effort.)